
Lab 2: Ohm’s Law

Figure 1: A simple circuit showing the fuse and switch that are internally connected on the Vernier Circuit Board

Overview

This also introduces you to Ohm’s Law, an essential electronic’s topic. This lab will involve the use of an ammeter, voltmeter,
lightbulb, resistor, and LED.

Safety Rules

Safety is essential to this course, and your lab instructors will be making sure to remind you of these safety rules every lecture.
Your quiz will include many questions on these safety rules because we think they are important. You will not work with
circuits that can hurt you in this class, but if you go to another class that begins working with higher voltage and current
systems you need to know these rules.

1. Never Work On A Circuit While The Power Is Applied.

2. Always Turn The Power Down Before Switching Off A Power Supply.

3. If You Smell Anything Burning (Or Your Resistor Is Warm To The Touch) Turn The Power Off At Once.

4. Never Work Alone.

For more information on these rules please see the Appendix.
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Figure 2: Example Vernier circuit board that we will use in all our experiments.

Ohm’s Law

Ohm’s Law states,

A potential difference of 1 volt will force a current of 1 ampere through a resistance of 1 ohm.[1]

Where this can be written as

V = IR,
Or I = V

R ,

Or R = V
I ,

Where V is voltage (volts), R is resistance (ohms) and I is current (amps). For a visual demonstration of what Ohm’s
Law looks like in a wire please see this PhET Simulation. Resistance is changed by temperature, so Ohm’s Law is commonly
understood to be for just one temperature. See this link for more information.

The LoggerPro Board

Looking at the board before you, you can hopefully see the labels on it. If not perhaps you can see the labels on Fig. ??.
Please see the Appendix for a more in-depth overview.
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Question 1 Getting Used to The Circuit Board

Take a picture of your circuit board, or use the blank board on your worksheet, and label all the components you will be using
or analyzing today. Include that picture in your worksheet, and include your labels on the circuit board. a Those components
includes:

• positive power input

• negative power input

• One 10 Ω resistor

• Lightbulb

• The Fuse

• The LED

• The Capacitor (to be used in Lab 3)

aFor a point breakdown, and some common mistakes, of each lab question, please see the rubric under the Canvas assignment for Lab 1: Safety.
Also lab partners may not submit the same labeled diagram.

Drawing Circuits

R1 = 2 Ω

Resistors are drawn as in image above with the label R1 = 2 Ω. The unit of resistance is the Ω symbol, which is called an
ohm. It’s SI base unit is kgm2s−3A−2.

C1 = 2 µF

Capacitor’s are drawn as in image above with the label C1 = 2µF . The µF symbol is called an micro Farad. It’s SI base
unit is 1kg−1m−2s4A2.

This is the symbol for a lightbulb, and we will be using this a lot today. Today you will work with the lightbulb to plot
their voltage vs current curves (also known as an I-V) curve.

ground rground cground

The symbols above are all possible symbols for ’ground’. On your power supplies you will often see the ’ground’ or GND
marking. They are often green on your power supplies.

s1

The diagram above is a switch. When a switch is ’open’ the circuit is off and current cannot flow through a circuit. When
a switch is ’closed’ the circuit can run.

Measurement symbols

A

The A above represents where an Ammeter should be placed. Ammeters measure current, and should always be placed
in series (interrupting the connection between two components) on a circuit. You will learn more about series versus parallel
connections later in this lab.
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V

Above is the symbol of a voltmeter. Voltmeters measure voltage, and should always be placed parallel (or around) to the
component being tested. As you can see in Fig. 5 the voltmeter symbol is placed such that it spans the 10 Ω resistor. The
voltmeter should always be placed around the component you are trying to measure the voltage of because otherwise it will
interfere with the system, and will not be recording the voltage in the system.

The full circuit diagram for a resistor under test would be

+
− DC R = 10 Ω V

A

Figure 3: This is an example circuit diagram. On the left we have the DC power supply input. In the middle is the lightbulb.
On the right is the voltmeter, which is parallel to the lightbulb. Then on the bottom of the circuit is the ammeter, which is
in series with the lightbulb and DC power supply.

Figure 4: Detailed view of the connections with a lightbulb as the device under test.
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Question 2 Practice drawing a circuit: Lightbulb

Looking at Fig. 4 which shows (from bottom left to right)

1. The negative side of the DC power supply connected to the black connector, J2.

2. The DC power supply (positive side) is connected to an ammeter.

3. Then from the other side of the ammeter is connected to the the red connector (J1)

4. Then there is an internal connection to the + connector

5. In parallel with the lightbulb is the voltmeter

6. which then that is finally connected to the negative input of the DC power supply

Please re-draw Fig. 4 with the appropriate symbols used above in the style of Fig. 5. a

aYou may draw it by hand, or using the Word Scribble function, but please make sure the quality is high enough for your lab instructor to read.
Lab partners may not submit the exact same circuit diagram.

Circuit Drawing, Continued

+
− DC R1 V

A

Figure 5: This is an example circuit diagram. On the left we have the DC power supply input. In the middle is the resistor
R1. On the right is the voltmeter, which is parallel to the resistor. Then on the bottom of the circuit is the ammeter, which
is in series with the circuit.

Below is the symbol for an LED, or light emitting diode. You notice that it has an arrow pointed one way, that is to indicate
what way the current should run. Then to illustrate it is a light emitting diode you notice the arrows pointed out. If the
arrows pointed in it would be a solar cell! The LED should be setup so that the negative side of the DC power supply
connects to the LED, and the positive side should be connect to the resistor side.

Figure 6: This is an example of an LED symbol.

positive side R1 negative side

Figure 7: This is an example of a resistor and LED together with the positive and negative side labeled. Positive side is on
the left, negative side is on the right.

The Basic Circuit

Please see this video for a brief introduction to the circuit boards.
In Fig. 8 is the simple circuit that you will be using for the first part of the lab. Note that the ammeter is in series with

the DC power supply while the voltmeter is in parallel with the resistor. The only change will be which component is used
in the circuit. While the DC power supply that you have is capable of outputting 15 volts at 1 amp, it is important that you
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do not exceed the limits of the voltmeter and ammeter and wires. If you feel or smell something hot, shut of your supply
and ask a TA to help check your circuit! The limits of the sensors are 0.6 amps (600mA) and 6 volts.

Figure 8: Detailed view of the connections with a resistor as the device under test.

The Circuit Board

There are number of resistors and other components on the Vernier circuit board that you each have at your lab station. We
will be using 1 of the resistors, a light bulb, and a light emitting diode (LED) today.

Below the resistors on the board is an LED in series with a resistor and below that are three light bulb holders. On either
side of the resistors and bulb holders are small metal posts, these are connected via a circuit board trace. You can use the
posts to more easily connect your wires.

The LED should always be hooked up with the resistor next to it, this acts as a current limiting resistor and protects the
LED from burning out. As with any diode, the LED will only pass current in one direction. The current should flow from
the negative side, to the LED, then to the resistor next to the LED. 1

Data Collection

1. Open Logger Pro on the computer and make sure that both the current and voltage probes are recognized. While the
current probe is disconnected from the circuit, connect the leads of the voltage probe together and zero the sensors in
the Logger Pro software, this procedure will help minimize any systematic error. You should repeat this process often,
certainly if you notice any odd measurements. Remember to connect the current probe before starting to collect data.

2. With the power supply off, connect the circuit as shown above in Figure 8 using the device that you would like to test
on the circuit board. We recommend starting with the lightbulb because it will emit light when it works.

3. Turn down the voltage and current knobs on the power supply, then turn on the supply. While watching
the display on both the computer and the power supply, slowly adjust the supply so you are outputting 5 volts, you
will have to adjust both the voltage and the current control as the output will be limited by the lowest setting.

4. At 5 volts the lightbulb or LED should be visibly lit. If your range is outside of this or your do not see illumination,
double check your circuit and then ask your TA to help.

1When setting up your circuits you are testing either the LED or the lightbulb, not both at the same time. That’s a very common misconception.
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5. When you are confident that your circuit is performing properly, collect data in logger pro for 10 seconds, you should
end up with 100 data points. You can change how data is collected by going to the menu item Experiment > Data

Collection and changing the collection time

6. Use the statistics feature to find the mean and the standard deviation for each graph (Click on the graph you want to
get statistics for, then under the Analyze menu, select Statistics). Use the standard deviation as the uncertainty for
the current and voltage.

7. Starting with the lightbulb, collect 10 data points in the same manner as above, each data point should be at a different
voltage between 0.1 and 5 volts. If you cannot take data at exactly 0.1V or 5.00 V that is fine, just try your best. 2

For the LED take 10 data points, 5 voltages before the LED turns on and 5 voltages after it turns on.

8. Collect data in this manner for a lightbulb and LED.Copy the table below and add titles so you have two
tables of data.

Voltage (V) Voltage Uncertainty (V) Current (A) Current Uncertainty (A)

Clean Up Procedure

Once you have collected all your data, and before you leave for the day please make sure to

1. Turn off power supplies. You may leave them plugged into the walls, but make sure they are off.

2. Leave Voltage and Current probes (Ammeter and Voltmeter’s) plugged in to the logger pro, but please make sure none
of the wires are touching the ground. Please also leave your green box plugged into your computer and at your station.

3. Unhook your wires from your circuit boards, and place the circuit board back in their white boxes.

4. Put wires back in the white box, or if there is no room in the white box then put them in the communal wire box that
is near the front of each room.

5. If you used a capacitor and attached it to the board please do not remove it from the board after connecting
it. Too much connecting and unconnecting will weaken or break the wires eventually.

2Always use the voltage your voltmeter reads, not the voltage on the DC power supply. Why do you think that is?
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Data Visualization and Analysis

After you have collected your 10 voltage, voltage uncertainty, current and current uncertainty for the lightbulb and LED you
should graph your data with the error bars. You can do that in Python or Logger Pro, but please do not use Excel unless
you can add the correct error bars.

1. Disconnect your sensors and open a new Logger Pro file (please reconnect the sensors for the next students when you
are finished)

2. Create 12 new manual columns in Logger Pro Data > New Manual Column for you to enter the data that you collected.
The new manual columns could be named: “lightbulb voltage”, “lightbulb voltage” uncertainty”, “lightbulb current”
and “lightbulb current uncertainty”; etc.

3. Create a new page Page > Add Page and insert a table using Insert > Table, make sure that the table is large enough
to show all of your new columns. You can now enter your collected data into the appropriate columns.

Figure 9: After you add a new page (Page > Add Page) select ’okay’

4. Double click on the top of each voltage column, which will cause the ’Manual Column Options’ option to open. Then
set your voltage uncertainty column as the source of error bars in the bottom right of the screen as shown in Figure
16. Do the same with each current column.

5. Create another new page and insert a graph. Set the graph axes to be Voltage on the y-axis and Current on the x-axis
for one of your components. Make sure that your error bars are visible on the screen and change the title of the graph
to correspond with the component that your data is from.
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Figure 10: Manual Column Options table, which you can access by double clicking on the top of your dataset columns, check
the “Error Bar Calculations” and “Fixed Value Box”. Then select the manual column that corresponds with your measured
uncertainties for that column of data.

6. Create a graph for each of your components (lightbulb, and LED) either on separate pages or together on the same
page.

7. Perform a linear fit on each graph where you think the data may be linear in nature and move the text box into a
position that does not cover the data points. Show the uncertainties in the fit by right clicking on the box, selecting
“Linear fit options” and checking the box marked “Show Uncertainty” as shown in Figure 17. Copy the graph in
to the results section of this file below, one for each component tested (a total of 3 graphs). Remember to format
the figures correctly and include a caption as described in the review below.

9



Figure 11: Graph options dialog, add a title, check the “Point Symbols” box and uncheck the “Connect Points” box.
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Question 3 Lab Modus Operandi

Communicate the steps that you took when collecting and analyzing your data.

Pretend you are writing this so a fellow student that missed this lab could take and analyze the data using only
this section. For example, you do not need to tell them to pres3 1q s start in Logger Pro or open the program, but you
would want to tell them what sensors you used to collect data and if there are any special settings that you used. (3-4 sentences)

In paragraph form, complete the following sections making sure to answer the questions posed in each section as a
guideline. You should include the graph you produced in Lab 1 of your lightbulb. If you did not do Lab 1 with the lightbulb
please talk to your lab instructor.

Question 4 Data Analysis

Please answer the questions below on your worksheet.

• For each of the three graphs (Resistor, LED and Lightbulb), identify the regions that are linear and those that are not
linear. (2-4 sentences)

• For those portions that appear linear, does the linear fit line pass within the error bars on the graph for each point?
(2-3 sentences)

• What are the units of the slope and what value does the slope represent? (1 sentence)

Question 5 Results

• For each of the components (resistor, lightbulb and LED), say what you can about the resistance. Use the actual numbers
and references to your figures when possible. (2 -4 sentences) a

aIf you do not have lightbulb data from Lab 1 to work with please talk to your Lab Instructor

Question 6 Conclusion

• What conclusions can you make about these three different components based on your experiments today? Think pri-
marily in terms of the relationship between voltage, current and resistance (Ohm’s Law).

• Do your results make sense based on what you know of physics? If not, what might be a reason for the discrepancy?

• What further questions do you have about this lab? How would you test those questions if you had the ability to do so?

Graph and Data Checklist:

You should have written an answer for each section highlighted by the gray boxes. Make sure that you used complete
sentences and that your conclusions match your results. You should also have collected 2 tables and 2 graphs
showing your data.

• Graph and table of LED’s voltage vs current. Graph has error bars and a trend line over the linear parts.

• Graph and table of Lightbulbs voltage vs current. Graph should have been made in lab 1. If you do not have
lightbulb data from the previous lab please talk to or email your lab instructor(s).

You also have a lab quiz on Canvas that will focus on what we worked through this week. That quiz is untimed, and
you have as many tries to pass it as you wish. The quiz is worth 5 points of your final lab grade.
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Question 7 Extra Credit: Creative Ohm’s Law Reinforcement

For up to 3 points of extra credit please create your own Ohm’s Law Meme! They do not have to be good, but please integrate
one of the concepts you have learned in class or in this lab about Ohm’s Law, and state what information you are trying to
convey.

Lab Instructor’s have final discretion if your meme makes sense or not. Please include a comment in your figure caption
for the meme that includes these two things. If you are fine with us posting your meme, please include how you’d want to be
attributed.

Partners cannot submit the same meme.
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Appendix

Circuit Troubleshooting

Figure 12: A trouble shooting breakdown for several situations if a resistor circuit is not performing as expected.

If you are having trouble with your circuit, first try seeing if your circuit can light up the lightbulb. It should turn on
between 1.5 to 2V. If it cannot try changing your DC power supply to look similar to figure 13. Also make sure your circuit
board is switched for external voltage. The switch is right under the battery holder.

Sometimes if your resettable fuse is tripped it can take a while to cool down. It won’t work again until the metal plates
inside of it cool down, so you can either wait a second for it to go back to room temperature, or bypass the fuse to make
your circuit work.
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Figure 13: The DC power supply should have a wire from ground to the negative output, then should go from ground to
follow the black wire on the diagram in figure 1 after the circle labeled ’DC’. Then the positive output, or red here, should
go to the current meter similar to the red wire coming out of the DC power supply on figure 1 .

Never Work On A Circuit While The Power Is Applied

This was written for much higher voltages and currents than the ones we will use, but the rule remains because you should
always practice good safety so to maintain the habit when it matters. These habits are learned through repetition, and one
of the learning objectives of this class is that you can practice good electronics safety without conscious thought.

To quote the Canadian Center for Occupational Health and Safety, (Canadian OSHA),

People are injured when they become part of the electrical circuit. Humans are more conductive than the earth (the ground
we stand on) which means if there is no other easy path, electricity will try to flow through our bodies...

These injuries can happen in various ways:

Direct contact with exposed energized conductors or circuit parts. When electrical current travels through our bod-
ies, it can interfere with the normal electrical signals between the brain and our muscles (e.g., heart may stop beating
properly, breathing may stop, or muscles may spasm).
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Always Turn The Power Down Before Switching Off A Power Supply

Similar to the concern above when you work with high enough voltages those power supplies are not always equipped to
handle large changes in power. Thus, if you were to switch the power supply off quickly the quickest path from the power
supply to ground could be through your hand turning the dial down, harming you in the process. When you approach a
power supply you make sure the power is all the way down before switching it on.

If You Smell Anything Burning (Or Your Resistor Is Warm To The Touch) Turn The Power Off At Once.

Resistors limits the flow of electricity through a circuit. Part of that process means slowing down the current as it travels
through the resistor. When the current slows down it produces heat as the electrons meet resistance.

Resistors are equipped to handle only so much power (Voltage time Current). That is indicated in their voltage rating,
and when a resistor is under their voltage rating they should be cool to the touch.

When a resistor encounters too much power, however, they warm up. If they warm up too much they can catch on fire.
If they catch on fire, or feel warm to the touch please turn the power down and leave your circuit alone until either it
feels cool to the touch or your Lab Instructor says it is fine. Resistors are cheap, and so at one point in the lab your Lab
Instructor might set one on fire so you all know what burning plastic smells like.

Link to an article on the physics behind this.

Never Work Alone In A Room

For the three reasons outlined above please never work alone in our labs with electronics. You should always have your
Lab Instructor, Dana (ldana@wpi.edu), or peer’s who are trained in basic electronic safety while working on electronics. If
something goes wrong you need someone else there to help out.

Figure 14: Example of three of the power supplies you may find in lab. Before turning the power supply on please turn the
current or voltage knob all the way down (counter-clockwise). If you are just approaching the power supply you should never
assume that the previous student did the correct thing and turned the power down themselves. If you were the last person
to turn the power supply off it is still useful to check and make sure you turned the voltage or current down before turning
the power switch on.
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The Figures and Caption Rules

There are a few very important aspects to creating a proper figure and caption. If you follow these rules, not only will you
get points on your physics lab grades, you will impress your instructors and peers in the future.

The Caption

• The caption should start with a label so you can reference the figure from other places in your paper/report. For this
course you should use “Figure 1”, “Figure 2”, etc.

• The caption should allow the figure to be standalone, that is to say, by reading the caption and looking at the figure,
it should be clear what the figure is about and why it was included without reading the whole paper.

• The caption should contain complete sentences and be as brief as possible while still conveying your information clearly
(this is not always easy).

• Please add captions to your tables as well, otherwise we will not know what we are looking at.

The Figure

• Make sure that the resolution is high enough to not be pixelated at its final size.

• Check that any text is readable at the final size (Using a smaller graph in Logger Pro will cause the text to be larger
in relation to the graph when inserted into another program).

• For graphs, ensure that the axes are labeled (including units) and that there is a legend if you have multiple data sets
on the same graphs.

Tables

• The first row of the table should be a header, where each item is labeled with what is contained in that row. If it is a
physical measurement it should have the correct units.

• For tables include a short caption of what is contained in the table, or what was examined.

• The caption should start with a label so you can reference the figure from other places in your paper/report. For this
course you should use “Table 1”, “Table 2”, etc. For an example of a good table caption please see Figure 15.

Figure 15: An example table from the paper Lianne Parkin, Sheila M Williams, and Patricia Priest, “Preventing Winter
Falls: A Randomised Controlled Trial of a Novel Intervention” 122, no. 1298 (2009): 9.

How to make a graph in LoggerPro

1. Disconnect your sensors and open a new Logger Pro file (please reconnect the sensors for the next students when you
are finished)

2. Create 4 new manual columns in Logger Pro Data > New Manual Column for you to enter the data that you collected.
The new manual columns could be named: “resistor voltage”, “resistor voltage” uncertainty”, “resistor current” and
“resistor current uncertainty”; etc.

3. Create a new page Page > Add Page and insert a table using Insert > Table, make sure that the table is large enough
to show all of your new columns. You can now enter your collected data into the appropriate columns.
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4. Double click on the top of each voltage column, go to the settings tab and set your voltage uncertainty column as the
source of error bars in the bottom right of the screen as shown in Figure 16. Do the same with each current column.

Figure 16: Table options dialog, check the “Error Bar Calculations” and “Fixed Value Box”. Then select the manual column
that corresponds with your measured uncertainties for that column of data.

5. Create another new page and insert a graph. Set the graph axes to be Voltage on the y-axis and Current on the x-axis
for one of your components. Make sure that your error bars are visible on the screen and change the title of the graph
to correspond with the component that your data is from.

6. Add a trend line if required

(a) To perform a linear fit on each graph where you think the data may be linear in nature,

i. Highlight the part of the graph that is linear.

ii. Select ’linear fit’

iii. Move the text box into a position that does not cover the data points. Show the uncertainties in the fit by
right clicking on the box, selecting “Linear fit options” and checking the box marked “Show Uncertainty”
as shown in Figure 17.

(b) To add a polynomial trend line,

i. Highlight the part of the graph that you wish to fit.

ii. Select ’Analyze’ then ’Curve Fit’.

iii. Select the equation you wish to apply to your curve.

iv. Select ’Automatic’ and then ’Try Fit’. That will change the parameters of your fit values. Once the fit looks
good please select ’OK’.

v. Then right click on the information box on the graph and select ’Fit Options’, and select ’Show Standard
Error’.

7. Copy the graph in to the results section of this file below, one for each component tested (a total of 2 graphs).
Remember to format the figures correctly and include a caption as described in the review below.
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Figure 17: Graph options dialog, add a title, check the “Point Symbols” box and uncheck the “Connect Points” box.
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Human Error

Humans can often be a source of error, but describing one’s total error as ’human error’ does little to illuminate the subject.
Humans can contribute error to a system, but it is not their mere presence, often, that causes that error. That error is
contributed by a specific action, or lack of action of the operator and you should always be specific. If we ask for why there
might be error in a system, and someone responses with just human error without explaining what, specifically, that answer
will not receive credit.

Figure 18: Example of a good figure with excellent error bars and a label. Figure from Philip Ilten of University College
Dublin [?].

Python

According to IEEE Spectrum, Python is the most popular programming languages. Python is a free, general purpose, cross
discipline programming language that has moved to the forefront of many disciplines.

If you decide to use Python your TA’s will help you troubleshoot your code. While they might be able to help you
troubleshoot when you use a different program or code, be aware of the fact that they are not familiar with all programming
codes. There are many languages (R, Matlab, Opal, Julia, etc.) out there that are just as useful as Python, but we have
chosen to use Python here. You may use any programming language you wish, but not Excel or Google Sheets.
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Figure 19: Navigate to jupyterhub.wpi.edu/hub/login and sign in with your WPI email address and password, choose an
instance to spawn (either is fine) and create a new Python 3 file as shown here

We have set up a Jupyter notebook you may use. The website is https://jupyterhub.wpi.edu/hub/login.3 There are
many ways to learn Python, including reading a book, asking a friend, working through examples, or googling furiously when
problems arise. We encourage you to discover which approach works best for you. Going forward this class will provide basic
Python examples, but feel free to iterate upon the template we provide. What we provide is a stripped down version, and
elaboration is encouraged. See this Github repository for our examples. We hope at the end of this term you will be able to
add to your resume ”Proficient in Python”.

Jupyter uses a cell based system and evaluated variables carry over to the next cell. There are a few different types of
cells, Figure 20 shows 2 kinds, the code cell, which we will be using most of the time, and the markdown cell, which you can
use to add nicely formatted notes to you file.

3If you cannot log in please email WPI’s IT department, and they will be happy to help polite students. The first thing they will tell you,
however, is to check to make sure you don’t have to change your password and try a VPN if you are off campus.
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Figure 20: Above is the code that you could use use to propagate uncertainty for values that are added or subtracted. Always
remember to comment your code.

If you prefer to work through a book or examples we recommend Mark Newman’s book, which is available for free on his
website [?]. Chapter Two is a basic introduction to the syntax for Python. Chapter Three covers graphs and visualizations,
and we hope you will look into it if you learn best from a book. If you wish to get a head start in this class we recommend
reading this book.

If you wish for a more advanced textbook there is a compilation of free online computational physics books here.

Extra Theory!

Electric Circuit

An electric circuit is a path for the flow of electric charge carriers (electrons and ions). A simple electric circuit consists of
a source of potential difference (p.d.) like a battery or a power supply, connecting wires, a resistor, and a switch. A circuit
in which a current is flowing is called a closed circuit and a circuit with an open switch or circuit-breaker is called an open
circuit. When a p.d. is maintained in a closed circuit, the charges flow and the flow constitutes a current. Thus, we define
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an electric current as the rate of flow of charge. Mathematically,

I =
dQ

dt
(1)

where dQ is the amount of charge that passes through the cross-section of a wire in time interval dT. In a metallic
conductor, the current is formed by the flow of electrons (charge = −1e = −1.610−19C). The electrons flow from the
negative terminal of a battery to its positive terminal through the external circuit.

Conventionally, the direction of current is considered in the direction opposite to the direction of motion of electrons, and
this is called the conventional current. The SI unit of current is Ampere (A). If 1 Coulomb of charge flows through a cross-
section of a conductor in 1 second, the current is 1 Ampere:

1A =
1C

1s
= 1Cs−1. (2)

Since 1A is a fairly large amount of current, the commonly used submultiples of ampere are milliampere (1mA = 10−3A)
and microampere (1µA = 10−6A).

To maintain a current in an electric circuit, we need to apply a potential difference (p.d.) or voltage across the circuit.
It can be done by using the sources of electric energy like a battery or a power supply connected to an alternating current
source.

Ohm’s Law

When a potential difference is applied across a resistor, it causes a flow of current through it. Ohm’s law states that the
current flowing through the resistor is directly proportional to the potential difference applied, provided that the temperature
of the resistor remains constant. Mathematically,

I ∝ V (3)

If I is the current (in amperes) flowing through the resistor and V is the potential difference (in volts), then, Ohm’s law can
be written as above. This means that if the voltage (V) across a resistor is increased, the current (I) increases linearly.

We can write Eq. 3 as
V = RI (4)

where R is the proportionality factor, and it is called the resistance of the resistor. The SI unit of resistance is Ohm
(Ω). For metallic wires at constant temperature, the resistance of a given resistor is constant. Note that p.d. (or voltage) is
measured by a voltmeter which is connected in parallel to the resistor across which the p.d. is to be measured and current
is measured by an ammeter which is connected in series in the circuit.

Resistance

Electrical resistance is the property of materials which opposes the flow of charges through them. The resistance is usually
denoted by R and the SI unit is Ohm (Ω).

The ratio of the voltage applied across a resistor to the current flowing through it gives the resistance of the resistor.

V

I
= R. (5)

For a simple metallic resistor at normal temperatures, R is constant. The resistors which demonstrate this behavior are
called Ohmic conductors. Semiconductor diode, ionized gases, and the glowing filament in a bulb the ratio V

I is not constant.
They are, therefore, are called Non- Ohmic conductors. The resistance of a wire given by

R = ρ
L

A
. (6)

where L is the length of the wire, A is its area of cross-section, and ρ is called the resistivity of the material of the wire.
The following figure shows a simple electric circuit with a battery which has an internal resistance r = 2 Ω. The battery

has an emf η = 12 V. An external resistance R = 4 Ω is connected in the circuit.

Electo Magnetic Force

The Electro Magnetic Force, or EMF, of a battery is equal to the potential difference in voltage when no current flows. It’s
unit is commonly η, and is measured in Volts. It is the amount of energy of the battery provided to each coulomb of charge
that passes through. An ideal battery, such as the ones in our Phet’s, have no internal resistance and the terminal voltage
is equal to the emf of the battery.
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In real batteries this is not the case, however for these remote labs you can measure the emf as the voltage you measure
across the battery.

Figure 21: Simple circuit with a battery.

In the above circuit, I is the conventional current, A is the ammeter, and V is the voltmeter. You will be constructing a
simple electric circuit like the one shown in the following figure:
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Figure 22: Example circuit in the PhET.

The following figure shows the electric circuit in Figure 2, drawn using electric circuit symbols. The ‘arrows’ represent
the direction of the conventional current.
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Figure 23: Example circuit with the resistor, lightbulb, battery, current meter, and voltage meter replaced by their symbols.
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